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1 Introduction

1.1 Introduction

This manual describes the features of the Natara Quanto™ time measurement tool
for Palm OS handheld devices (PDA).

Improve your productively or life style by analysing how you spend your time.

· Show your boss (maybe you) why it's hard to get work done on that project.
· With your crazy schedule are you getting enough sleep?
· How is your balance of work and family?

PalmOne Tungsten T5 full screen support

Quanto is provided as a 3 day fully functional trial version. If you find the application
useful, please purchase a license for continued use.

1.2 Installation

Installing the Natara Quanto time measurement tool onto your handheld PDA device
only takes a few steps. The following example shows the steps required when using
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a desktop machine running the Windows operating system. Consult the user manual
provided with the handheld synchronization software if you use another desktop
operating system, for example Mac OS X or Linux, for instructions on installing a
Palm OS application file.

Locate the directory where you extracted the Quanto files.

Double-click on the Quanto Palm Application file (extension PRC) to launch the Palm
Install Tool or the PalmOne Quick Install depending on your handheld PDA device
model.  Quanto should be listed as one of the files to be installed.

Click on the Done button.  Place your handheld PDA device in its cradle and push
the button to start a synchronization.  When the synchronization completes, tap the
home button to display the application launcher.  The Quanto icon will be displayed
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on the application launch screen.

Tap on the Quanto icon and the application will display the Current Activity view.
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1.3 Menus and Toolbars

The most commonly used commands are provided as toolbar buttons on the bottom
of each screen. The full list of toolbar buttons is provided under the reference topic of
this user manual.

All commands are available on the menus. Depending on your handheld PDA device
model, the menu is displayed by tapping the menu button on the silk screen area,
tapping a menu button on the status bar, pressing a menu button, or tapping the title
bar. Refer to your handheld PDA device user manual if you are unfamiliar with how
to access menus on your handheld.

Most commands have menu shortcuts. The shortcuts are shown next to each
command on the menus. Refer to your handheld PDA device user manual for
instructions on how to invoke a menu shortcut. The full list of shortcuts is provided
under the reference topic of this user manual.

1.4 Purchase a License

You can purchase a license for Quanto from the Natara website at
http://www.natara.com/quanto/purchase.cfm.

After purchasing a license, you will receive a registration number by email (usually
within the hour). Follow the instructions in the email to enter your registration number
in the registration number dialog.

http://www.natara.com/BuyNow?Product=Quanto&Retailer=Natara&Version=1.1.1.122&Days=-2&Pt=3
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Lost Registration Numbers

Visit the Natara web site www.natara.com to request your registration number if you
misplace it.

HotSync User Name Change

If you change your HotSync User name you can continue to use the original
registration code by entering the original HotSync User name in the User field.

1.5 Requirements & Limitations

1.5.1 Requirements

The Quanto handheld PDA device application has the following requirements:

· Approximately 2 MB of disk space for user manual and installation files.

For Palm OS handhelds
· Palm OS 5.0 or higher.
· 200 Kilobytes of memory for the application (activity database requires additional

memory).
· External memory card required for Export features.
· The PalmOne Tungsten T3 handheld requires additional libraries supplied by

PalmOne for full screen support.
· The Pie Chart requires services from the MathLib library.

http://www.natara.com
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1.5.1.1 MathLib

The Pie Chart requires services from the MathLib library. Some handhelds, like the
Tungsten E, do not have this library installed by default. The library can be
downloaded from http://www.radiks.net/~rhuebner/mathlib.zip.

MathLib is not part of this application and you are not paying anything for its use; a
copy is simply included with this product download for your convenience. The
MathLib.PRC is included in the file MathLib.zip that is part of the Quanto download.

1.5.2 Limitations

Quanto has the following limitations.

· Timing is done with a resolution in minutes.
· The number of activity records is limited to about 32 thousand.

1.6 Uninstalling

To uninstall the application from your handheld;

· Go to the application launcher screen on your handheld PDA device.
· Tap the Menu button and select Delete from the App menu.
· Select Quanto from the list of applications and tap Delete

Note: Uninstalling the application will also delete the activity database from your
handheld PDA device.

1.7 What's New

Changes in version 1.1.1

· Added a date range preference for the statistics.
· Added Check for Update command to the Options menu.

http://www.radiks.net/~rhuebner/mathlib.zip
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2 Configuration

This chapter contains topics on how to configure the application for use on your
handheld PDA device.

2.1 First Time

The first time you run Quanto on the handheld PDA device it will suggest that you
customize your list of activities.

The list of activity names that you use will depend on what aspect of you life you are
analysing. Quanto installs with a default set of activity and detail names. By
customizing the lists you can get the most out of the application.

2.2 Activity Names

Using this dialog you can customize the list of activities that are available for use.

Place the more frequently used activities towards the top of the list to speed the start
of new activities.
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Note: Changes to the names in this list does not affect the activity history.

2.2.1 Detail Names

This dialog is used to customer the detail name list. There is a separate detail name
list for each activity name.

Place the more frequently used names towards the top of the list to speed the start
of new activities.
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2.3 Application Preferences

This dialog is used to customize the application. Select the Preferences command
from the Options menu to display this dialog.

Button launch starts activity
When this is checked and Quanto is launched using a hard button a new
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activity will be started. To use this option you must configure one of the hard buttons
to launch Quanto. This is usually done through the Prefs application.

Exclude listed from Stats
Use this option to exclude some activities from the statistics. For example, you

may want a view of "What did I do during my waking hours". Tap on the Edit List
button to enter the activities to exclude.

Only include activities from
Use this option to limit the time frame used to create the statistics. To include

activities from a single day the first and second dates should be the same.

2.3.1 Exclude from Stats

This dialog is used to specify activities that should be excluded from the statistics.

2.4 Font Size

On most handheld PDA devices, a smaller font size can be selected to increase the
amount of information displayed on the screen. Use the Font command on the
Options menu to change the font size.

The History and Stats view font sizes are independent.
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Note: The number of fonts available is dependent on the handheld PDA device
model. High resolution handhelds (320 x 320) usually have a selection
of 8 fonts.
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3 Main Views

This chapter contains topics that describe the 4 main views. Switching between the
main views is done by either tapping one of the toolbar icons or selecting the view
from the View menu.

The toolbar icons for switching views are:

Display the current activity view.

Display the history view.

Display the statistics view.

Display the pie chart view.

3.1 Current Activity View

This view displays the current activity.

Tap the Start New Activity toolbar button  to finish this activity and start a new one.
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Quanto will make a guess at the activity name and detail based on past history.

Tap the Interrupt toolbar icon  to start the activity interrupt timer. Tap the Resume

toolbar icon  when the interrupt is over.

3.1.1 Activity Interrupt

It is not uncommon to have a longer duration activity interrupted. For example, a
phone call might interrupt the review of a long document. Recording these
interruptions may help in analysing your productivity.

One way to capture the interruption would be to start a new activity, and when the
interruption was done, start another new activity resetting the original activity name
and detail.

Quanto has a shortcut to accomplish this sequence of steps. Tap the Interrupt

toolbar button  when an activity is interrupted. A timer will be displayed to show
the length of the interrupt. The Interrupt button on the toolbar will also change to
show that an interrupt is in progress. When the interrupt is done tap either the Done

button or the Interrupt toolbar button . Quanto will perform three actions.

· The original interrupted activity will be given a finish time of when the interrupt
started.

· An activity will be added for the interrupt.
· A new activity will be started with the same activity name and detail as the

original interrupted activity.
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If the interrupt was started by accident, or does not last long enough to matter, tap
the Cancel button.

3.2 History View

This view is used to review the sequence of past activities. The start time and date of
each activity is shown.

In addition to changing an activity using the details dialog you can delete or split an
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activity.

3.2.1 Activity Details

This dialog shows the details of a single activity. You can change the activity and
details selections. You can also change the start and finish times. When you change
the start or finish times the activities that precede or follow the activity are updated so
that there is no gap or overlap.

3.2.2 Split Activity

This dialog is used to split an activity into two activities. The split at time will be used
to set the end time of the first activity and the start time of the second activity. After
the activity has been split you can change the activity names to reflect what was
done during each time period.
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3.3 Statistics View

This view displays the total time in minutes and percentage of each activity.

Drill down to show the statistics for the details of a single activity by tapping on a
selected activity name or using the select button.

Use the application preference setting to restrict the activities used to generate the
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statistics to a single day or date range. The day or date range will be shown on the
title and the next and previous buttons will be displayed on the toolbar. The next and
previous buttons will move the date range by the length of the range.

Note: If you want a view that shows how you spent your 'waking hours' use the
preference to exclude activities that you name.

3.4 Pie Chart View

This view displays the statistics in the form of a pie chart.

If you tap on a segment when viewing All Activities the view will drill down into the
details of that activity. If you tap on the chart when viewing the details the view will
again show All Activities.

The pie chart will display the same date range of activities as shown on the Statistics
View.
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4 Other Dialogs
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4.1 Export

This dialog is displayed when exporting the Quanto activity database.

Two export formats are supported; comma separated value (CSV) and XML. The
export file is written to the directory "Palm/Programs/Natara/Quanto".

Note: The Export command requires an external storage card..

4.2 Purge

The Purge command is used to remove old activity records from the database. When
OK is tapped all activity records that finish on or before the date will be permanently
deleted from the database.

You may want to export the old activity information to the storage card before
deleting it.
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5 How Do I ... ?

This chapter contains step-by-step instructions for a number of common tasks.

5.1 Delete old records

The Purge command can be used to delete old records.

Note: Purged activity history records can not be recovered.

5.2 Backup the activity database

The activity database is named "QuantoDB_NQto". This database will be backed up
by the HotSync Manager System conduit to your backup folder under your HotSync
Manager user directory when you synchronize the handheld PDA device. For extra
protection, the backup folder should be part of your desktop backup.

Changes to the list of activity and detail names are stored in the database named
"QuantoActivityDB_NQto".
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6 Reference

6.1 Toolbar Icons

Display the current activity view.

Display the history view.

Display the statistics view.

Display the pie chart view.

View and change the application preferences.

Start a new activity.

Interrupt the current activity.

Resume the interrupted current activity.

Move the time period for the statistics to the previous period.

Move the time period for the statistics to the next period.

6.2 Menu Shortcuts

The menu shortcuts for Quanto are as follows.

· A View and edit the activity names list.
· B Go to the bottom of the view.
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· C Display the current activity view.
· D Delete the selected activity history record.
· E Display the details of the selected activity history record.
· F Select a font.
· G Purge old activity history records.
· H Display the history view.
· L Split the selected activity history into two activities.
· N Start a new activity.
· O Go to the top of the view.
· P Display the pie chart view.
· R View and edit the application preferences.
· S Display the statistics view.
· U Interrupt the current activity.
· X Export the information to the storage card.
· Y Cancel the activity interrupt.

6.3 Contacting Natara Software

Sales questions: sales@natara.com

Support for registered customers: support@natara.com

Natara web site: http://www.natara.com

Forums: http://www.natara.com/forums (this is a great place to keep in touch with
Natara and other customers!)

Phone: (630) 870-1158
Skype: natarasupport

Mail: 909 E. Ogden Ave.
Suite C
Naperville, IL 60563-2885
USA

Note: When reporting problems, be sure to be as specific as possible.

Include:
· Which product you are having trouble with.
· What is the make and model of the phone you are using.
· Palm OS version (3.5, 5.0, etc.) of your handheld.
· What desktop operating system ( Windows 2000, XP, Windows ME, etc.)  
· Steps to reproduce the problem.  

http://www.natara.com
http://www.natara.com/forums


Quanto User Manual26

© 2006 Natara Software

6.4 Software License Agreement

-IMPORTANT-

Read This Carefully Before Installing The Software

THIS IS A LEGAL AGREEMENT BETWEEN YOU AND NATARA SOFTWARE,
INC. BEFORE CONTINUING WITH THE INSTALLATION OF THE PROGRAM,
YOU MUST READ, ACKNOWLEDGE AND ACCEPT THE TERMS AND
CONDITIONS OF THE SOFTWARE LICENSE AGREEMENT WHICH FOLLOWS.
IF YOU DO NOT ACCEPT THE TERMS AND CONDITIONS OF THE SOFTWARE
LICENSE, YOU MAY RETURN THE MEDIA PACKAGE AND ALL
ACCOMPANYING ITEMS (INCLUDING WRITTEN MATERIALS AND BINDERS
OR OTHER CONTAINERS), TO THE PLACE YOU OBTAINED THEM FOR A
FULL REFUND; OR YOU MAY WRITE, NATARA SOFTWARE, INC., 909 E.
OGDEN AVE. SUITE C, NAPERVILLE, IL 60563.

NATARA SOFTWARE LICENSE

1. GRANT OF LICENSE. Natara Software, Inc. ("Natara"), grants to you, the end user, a
personal, nonexclusive license to use a single copy of this software program, including any
updates, additional modules, or additional software provided by Natara in connection
therewith (the "Software"), solely for your own use, and solely in accordance with the terms
and conditions of this license agreement. You may copy the Software into the memory of any
computer, solely as necessary to use the Software in accordance with this license agreement.

2. INSTALLATION AND USE. Natara Quanto is licensed to you in one of two potential
configurations: (1) Single User License and (2) Evaluation License. You may install and use
(in the manner provided) only those configuration(s) for which you have obtained a license.
Licenses for Natara Quanto are individual named user licenses. No license may be shared, in
any capacity, by more than one individual end user.

(1) Single User License. You may install and use a single copy of the Software on a single
handheld device.

(2) Evaluation License. You may use one copy of the Software on a single handheld device,
for a period not to exceed three (3) days. You are acquiring only the limited right to use a
single copy of the Software for evaluation purposes. You are not acquiring any rights to the
Software itself. After the three (3) day period you may purchase a license for continued use or
remove the Software together with all copies, modifications and merged portions in any form.

3. COPYRIGHT AND COPIES. The Software (including any copy thereof), is owned by
Natara or its suppliers and is protected by United States copyright and patent laws and
international treaty provisions. The Software copy is licensed, not sold to you, and you are not
an owner of any copy thereof. You may either (a) make one copy of the Software solely for
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backup or archival purposes, or (b) transfer the Software to a single hard disk provided you
keep the original solely for backup or archival purposes. You may not otherwise copy the
Software except as expressly authorized by applicable law, and you may not copy the written
materials accompanying the Software. Natara hereby reserves all rights not explicitly granted
in this software license agreement.

4. OTHER RESTRICTIONS. You may not rent, lease or transfer the Software. You may not
reverse engineer, decompile or disassemble the Software, except to the extent expressly
authorized by applicable law.

5. LIMITED WARRANTY AND REMEDY. Natara warrants the physical media (e.g.
diskette(s) or CD-ROM), if any, and the physical documentation, to be free of defects in
materials and workmanship for a period of 90 days from the original purchase date. If Natara
receives notification within this warranty period of any such defects and such notification is
determined to be correct, Natara will, at its sole option and discretion, repair or replace the
media or documentation, or provide you a full refund. The foregoing is your sole and
exclusive remedy and states Natara's and its suppliers' entire liability arising out of this
warranty. This limited warranty is void if the damage or defect has resulted from accident,
abuse or misapplication.

6. NO OTHER WARRANTIES. THE LIMITED WARRANTY ABOVE IS
EXCLUSIVE AND IN LIEU OF ALL OTHER CONDITIONS AND WARRANTIES
FOR THE SOFTWARE AND DOCUMENTATION. NATARA AND ITS SUPPLIERS
MAKE NO OTHER CONDITIONS OR WARRANTIES, EXPRESS, IMPLIED,
STATUTORY OR OTHERWISE, AND EXPRESSLY DISCLAIM ALL OTHER
CONDITIONS AND WARRANTIES, INCLUDING BUT NOT LIMITED TO
IMPLIED CONDITIONS OR WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT FOR THE
SOFTWARE AND DOCUMENTATION, TO THE FULLEST EXTENT PERMITTED
BY APPLCABLE LAW.

7. LIMITED LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT AND UNDER NO LEGAL THEORY SHALL
NATARA OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY COSTS OF
SUBSTITUTE PRODUCTS, OR FOR ANY CONSEQUENTIAL, SPECIAL,
INCIDENTAL, PUNITIVE OR INDIRECT DAMAGES OF ANY KIND ARISING
OUT OF THE LICENSE OF, USE OF, OR INABILITY TO USE ANY NATARA
SOFTWARE OR DOCUMENTATION, EVEN IF NATARA HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL NATARA'S OR
ITS SUPPLIERS' LIABILITY EXCEED THE LICENSE FEE PAID BY YOU. THIS
LIMITATION OF LIABILITY AND RISKS IS REFLECTED IN THE PRICE OF
THE SOFTWARE LICENSE.

8. TERM. This license is effective until terminated. You may terminate it at any time by
destroying the Software together with all copies, modifications and merged portions in any
form. It will also terminate automatically upon your failure to comply with any term or
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condition of this Agreement. In the event of such termination, you agree to promptly destroy
the Software together with all copies, modifications and merged portions in any form.

9. MISCELLANEOUS. This is the entire Agreement between you and Natara, and
supersedes any prior agreement, whether written or oral, relating to the subject matter of this
Agreement. This Agreement is governed by the laws of the State of Illinois, U.S.A., without
reference to conflict of laws principles. All disputes arising out of this Agreement shall be
litigated or otherwise resolved exclusively in the state of Illinois. If any provision of this
Agreement is ruled invalid, such invalidity shall not affect the validity of the remaining
portions of this Agreement.
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